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1. L’art de la correction couleur :

Depuis 30 ans, DaVinci est le pionnier pour le développement des hardwares et softwares 
dans le monde de le correction couleur.

DaVinci Resolve 9 est l’un de ces produits leader dans les applications de colorimétrie. 
Un logiciel puissant reconnu dans le monde professionnel pour des outils précis et un 
dialogue avec de nombreux logiciels comme Final Cut Pro X, Avid, Première Pro CS6  
entre autres.

Une puissance dorénavant accessible par tous avec la version LIte du logiciel. Cette 
application gratuite nous donne accès à toutes les fonctions d’étalonnage avec un 
nombre illimités de Nodes, des possibilités de corrections couleur comme dans sa version 
Pro avec des primaires et secondaires, des Qualifiers pour des retouches couleurs, des 
trackings puissants et des exportations professionnelles pour le dialogue avec des 
logiciels extérieurs. 

Les seules limitations du logiciel gratuit de Blackmagic sont :

• Le format utilisé sera HD au maximum 1920x1080 pixels.
• Pas de possibilité de travailler en Stéréoscopie.
• Les fonctions de dé-bruiteur d’image sont inhibées.

Mais toutes ces fonctions ne sont pas forcément vitales pour la majorités d’entre vous.... 

Alors laissez vous guidez et entrons dans le monde du «Color Grading» avec DaVinci 
Resolve 9.1 Lite.
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1.1 Optimiser le Look de vos médias :

L’aspect fondamental de l’étalonnage est de donner à chaque image une correction 
colorimétrique la plus proche possible de l’ambiance d’un film voulue par le réalisateur ou 
le chef opérateur.

Lorsque l’on étalonne un film, il faudra modifier les ajustements de la couleur et du 
contraste de chaque image. Pour améliorer les finesses de l’image, on jouera sur les 
différentes zones de l’image pour se rapprocher de l’ambiance globale du film ou du 
documentaire.

L’étalonnage réside dans l’art de faire que chaque plans se raccordent les uns par 
rapport aux autres en donnant l’ambiance du film.

Aujourd’hui les caméras numérique comme l’Arriflex, la BMCC ou encore les réflexes 
numériques, nous fournissent des images aux formats RAW, LOG C ou encore Style 
Neutre.

Ces formats nous permettent de préserver au maximum la plage des réglages sur 
les basses et hautes lumières pour l’étalonnage.  

Toute la finesse des corrections couleur dépendra surtout de la qualité de vos images lors 
de la prise de vue.
Il est évident qu’avec des images RAW provenant d’un ARRI ALEXA ou d’une RED EPIC 
vous obtiendrez une latitude de correction bien plus élevée qu’avec des rushes d’un 
Canon 5D qui sont au format H264 avec seulement un débit de l’ordre de 45 Mbit/s.

Cependant, le logiciel vous fournira de nombreux outils pour améliorer les images et leur 
donner un meilleur aspect tout en essayant de retranscrire l’ambiance d’un film.

L’Onglet Qualifier pour une retouche limitée sur une couleur.
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Remarque :

Lorsque l’on travaille avec des caméras professionnelles, on aborde souvent les thèmes 
de LOG C, REC 709 ou encore de Profile Neutre pour les DSLRs comme les Canon ou 
Nikon.

Les formats logarithmiques «LOG» permettent de respecter une courbe linéaire de 
l’échelle des gris avec une légère correction de gamma de 0,45 pour pouvoir restaurer un 
signal dit linéaire. Ces formats permettent d’avoir une plus grande latitude 
d’enregistrement dans les basses et hautes lumières.

Le format REC 709 quand à lui est la norme actuelle pour le format numérique. Il utilise 
une correction qui permet de restituer correctement les couleurs et leur contraste, il est 
utilisé dans de nombreux logiciels comme After Effects pour restituer une image dans le 
visualiseur.

Les Profils neutres, eux sont des réglages que l’on retrouve dans les DSLRs pour 
essayer de conserver toute la latitude du signal comme le font les LOGs. Vous avez le 
style Neutre des Canon ou encore le Cinestyle de Technicolor.
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2. Les outils de DaVinci Resolve :

Pour travailler l’image dans un logiciel de colorimétrie nous devons intervenir sur  :

• Les Primaires pour l’étalonnage général de premier niveau sur l’image qui 
correspond à l’amélioration des contrastes.

• Les secondaires qui vous permettront par la suite de modifier une partie de 
l’image comme un ciel bleu ou un détail d’une voiture.

L’Onglet Color Wheels pour les corrections Primaires de l’image.

Ci-dessus les roues colorés nous permettent de modifier directement une image 
complète en jouant sur le niveau des noirs, le gamma ou encore le gain. 
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L’interface du logiciel vous donne accès à de nombreux paramètres, à vous de bien les 
organiser et de les comprendre pour optimiser vos images.

Ensuite DaVinci vous propose des outils de masques, de stabilisation, de tracking 
d’image pour suivre un mouvement etc....

Utilisation d’un masque circulaire pour limiter une zone de retouche colorimétrique.

Ci-dessus création d’un masque à l‘aide de ce que l’on appelle des «Nodes». Ces 
réglages sont importants dans DaVinci, car ils permettent de travailler avec des masques 
d’image, Qualifiers ou encore les keys. Ils sont paramétrables et si besoin est, on peut à 
l’aide du tracking, suivre une zone en mouvement. 

D’autres fonctions permettent de faire une sélection de zone par chroma key que l’on 
appelle Qualifier. Cette sélection permet par exemple de modifier une couleur de peau ou 
encore un ciel pour lui donner plus d’intensité ceci sans altérer le reste de l’image.

Utilisation du Qualifier pour sélectionner seulement une couleur dans l’image.
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Des outils comme les «Stills» dans la Gallery, vous permettrons de comparer une source 
par rapport à une autre pour garder une même teinte ou encore appliquer un réglage d’un 
plan sur l’autre.

Utilisation du mode Wipe entre deux sources.

3. Installer l’application :

DaVinci Resolve est téléchargeable à l'adresse suivante : lien de la page.

Dans certain cas d’installation vous serez amené à mettre à jour votre version du driver 
CUDA surtout si vous possédez une carte graphique NVIDIA.

Lors de l’installation du logiciel, si vous possédez des cartes graphiques Nvidia, les drivers 
CUDA seront installés automatiquement.
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Dans l’image ci-dessous, il est nécessaire de mettre à jour le driver CUDA, on cliquera 
sur Install CUDA Update. Puis, suivez les instructions d’installation. 

La version CUDA nécessaire pour un bon fonctionnement
de la version Lite 9.1 sera la version 5.0.36 de CUDA.

DaVinci Resolve ne fonctionne que sur des machines en 64 bits, ce qui n’est pas le cas 
si votre processeur n’est pas au dessus d’un Intel Core 2 Duo.

Vous devrez vérifier cela avant de commencer. 
Rendez vous dans la Menu Pomme de votre machine pour vérifier :

• A propos de ce mac.

Puis choisissez Plus d’Infos et regardez la partie Logiciel :
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• Si la ligne : Noyau et extensions 64 bits : OUI 

Cela signifie que vous êtes bien en 64 bits. Sinon, il vous faudra redémarrer votre 
machine avec un petit logiciel pour tester et configurer ce paramètre.

3.1 Mettre son ordinateur en 64 bits :

Première méthode :
Redémarrez en maintenant les touches 6 et 4 de votre clavier. Ceci aura pour effet de 
redémarrer le mac en mode 64 bits mais de façon temporaire. Au prochain démarrage, il 
reviendra en mode 32 bits.

Deuxième méthode :
Téléchargez «Kernel Startup Mode Selector 1.5» : lien de téléchargement.
Installez le et faites les tests proposés par le logiciel :

Quittez le et redémarrez la machine.

3.2 Installer DaVinci Resolve 9 :

L’application DaVinci Resolve est une application multi-utilisateurs. Vous avez la 
possibilité de démarrer avec l’un des comptes suivants :

• Administrateur
• Invité
• Utilisateur qu’il vous faut créer pour retrouver vos paramètres et vos 

projets.

Pour paramètrer le logiciel,  il faudra régler le dossier de travail. Il se sert d’une base de 
donnée de type QPSQL donc si vous voulez travailler sur plusieurs ordinateurs, il vous 
faudra paramétrer le chemin d'accès de cette base sur un disque externe.

Cliquez sur le symbole base de donnée en bas à droite de la fenêtre d’ouverture :
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Création d’un compte utilisateur personnalisé.

Pour créer un nouveau chemin cliquez sur le +, puis, dans Driver sélectionnez Disk.

Création d’une nouvelle base de donnée sur disque externe.

Cliquez sur «Host» pour déterminer l’emplacement et créer le dossier sur votre disque 
externe.
Donnez lui un nom dans «Label»  et finissez en validant avec OK.
Pour utiliser cette base de donnée sur le Disk, sélectionnez la dans le menu de la gestion 
des bases. 

DaVinci Resolve sauvera désormais toutes les données sur cette nouvelle base de 
donnée sur un disque externe.
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3.3 La base de donnée :

Pour mieux comprendre l’utilisation d’une base de donnée, on va voir comment les 
données sont gérées dans chaque base.
Voici comment sont stockées les informations dans chaque base de dnnées :

Database > Users > Projects > Timeline > Clips > Timecode > Versions > PTZR/
Grade.

Chaque base est organisée avec un numéro d’utilisateur (users). Chaque utilisateurs peut 
avoir plusieurs projets. Chaque projet peut contenir plusieurs Timelines qui eux mêmes 
contiennent plusieurs clips. Chaque clip possède une information de timecode et de 
bobine, et chaque version possède des informations sur les données d’ajustements avec 
les paramètres des sources et les différents réglages colorimétriques.

Dans le cas de problème de gestion de ces bases de données, vous pourrez les retrouver 
dans votre ordinateur.  
Chaque base de données crées par DaVinci sont localisée dans un fichier caché qui se 
trouve :

• Mac OS X :
! Library/Application Support/Blackmagic Design/DaVinci Resolve/ Resolve Disk 
Database

• Windows :
! C:\ProgramData\Blackmagic Design\DaVinci Resolve\Support\Resolve Disk 
Database

N’essayer pas de modifier ou déplacer ces fichiers sous peine de ne plus pouvoir 
faire fonctionner le logiciel.

4. Démarrer un projet :

Nous allons commencer par ouvrir DaVinci resolve 9 pour y aborder les différentes 
fenêtres du logiciel :

• Connecter les partitions, et gérer les médias.
• Importer des clips, et les conformer pour notre travail.
• Faire les corrections couleur.
• Et pour finir exporter notre travail ou retourner dans le logiciel de montage.

Ces étapes sont les principales pour un workflow simple. Par la suite nous explorerons le 
logiciel en profondeur.

4.1 Ouvrir un nouveau projet :

Lorsque vous installez pour la première fois le logiciel, vous devrez créer un compte 
utilisateur pour gérer votre projet. Si vous désirez aller plus vite, vous pourrez vous 
servir du compte administrateur.
Mais il est conseillé d’avoir son propre compte pour garder ses propres réglages sur des 
stations où plusieurs étalonneurs peuvent travailler.
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Une fois le programme ouvert, choisissez un compte ou créez en un :

Choisissez un Username, un mot de passe et une image si vous le souhaitez....

Une fois votre compte validé, une fenêtre de projet apparaitra, double cliquez sur le projet 
par défaut (celui qui s’affiche) :
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Vous arrivez sur le premier onglet du logiciel : l’onglet Média

4.2 Valider les partitions connectées :

Pour pouvoir travailler, il vous faudra valider les partitions connectées au logiciel pour qu’il 
puisse les voir dans la Librairy :

Ouvrez les Préférences du logiciel :

System Overview : montre la ou les cartes actives de votre ordinateur. Ici on travaille sur 
un Imac 2012 avec une carte graphique ATI Radeon HD 6970M.
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Media Storage : vous permettra de rajouter des partitions au disque de travail. Appuyez 
sur + et choisissez le dossier ou les volumes à rajouter.
Cette action rend visible les volumes accessibles par le logiciel dans la Page Media.

En appuyant sur + vous pouvez rajouter un nouveau disque dur connecté à votre 
ordinateur. Validez le chemin d’accès puis sauvegardez le changement en appuyant sur 
SAVE.

Relancez l’application pour prendre en compte les nouveaux disques connectés.

Video Capture Hardware : affiche la carte d’interface qui nous permettra d’acquérir des 
médias ou de sortir sur un moniteur externe.
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Control Panels : pour connecter une interface de travail ou surface de contrôle, dans 
notre cas, nous travaillons avec une souris.

Advanced : qui est réservé au débuggage et fonctions avancées du logiciel.

Si vous avez modifié un réglage,
n’oubliez de sauvegarder vos modifications en appuyant sur Save

et redémarrer le logiciel pour les prendre en compte.

5. La page Média :

La première des cinq pages du logiciel. Elle vous permettra d’importer manuellement les 
médias dans la Librairy qui ne sont pas associés à des projets ultérieures. 

Lorsque vous télécharger le logiciel de la page de Blackmagic, vous pouvez aussi 
télécharger les fichiers d’exercices. 

Gestion des médias dans l’Onglet Librairy.
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Placez les exercices où bon vous semble sur votre disque dur. 
Puis allez les chercher dans la «Library» à l’emplacement choisi auparavant.

La liste des disques connectés à DaVinci Resolve est divisé en deux catégories de 
volume :

• Scatch volumes : représentés par un icône de globe sont les disques que 
vous avez rajoutés dans la fenêtre de préférences du logiciel. Le disque placé 
le plus haut sera celui où sont stockés les Stills de la Gallery et les fichiers 
temporaires.

• Available volumes : représentés par un icône de disque, sont les disques 
durs disponibles  connectés à votre machine qu’ils soient fixes, externes ou 
encore sur le réseau.

Sur cette page, vous pouvez lire les médias dans le visualiseur ou Viewer, voir les 
informations associées (métadatas du fichier) et pour chaque clip lire le son présent.

Visualisation des médias dans le visualiseur du logiciel.
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Ci-dessus, nous avons importé tous les fichiers de notre sélection dans le Medias Pool. 
Pour importer les fichiers, voir le prochain paragraphe.

Vu-mètres audio :

Le logiciel peut gérer jusqu’à 16 pistes audio suivant le format de votre média. Si vous 
possédez un écran avec 2560x1440 pixels vous pourrez voir les 16 pistes affichées, par 
contre avec une autre résolution de moniteur, vous ne verrez que 8 pistes affichées. 

On peut gérer notre écoute ou la visualisation des pistes en les mettant ON/OFF en 
cliquant dessus, on a un bouton Mute global sur la gauche de l’affichage

Le niveau de référence par défaut est aligné sur -20dBFS (full scale), cette valeur 
peut se régler dans une échelle entre -24 et -15 dBFS dans le Projet Settings.

En France la valeur de référence est -18dBFS.

Réaménagement de la présentation globale des fenêtres : 

En déplaçant la bordure centrale, vous avez la possibilité d’agencer les fenêtre en 
elles.

Pour remettre la valeur par défaut : View > reset UI layout. (UI : User interface : 
interface utilisateur).
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5.1 Configurer le Frame Rate du projet :

Avant de démarrer quoi que ce soit, il faudra bien vérifier dans les préférences du 
projet que l’on va conformer notre projet dans la bonne fréquence d’image 

correspondant au montage source.

Vérifiez le Frame Rate de vos sources avant d’importer vos plans, en choisissant un plan 
dans la Library puis lisez les Metadatas du clip :

Ci-dessous, on a un clip en NTSC, avec un frame rate de 29,970 fps. On réglera notre 
projet dans ce format dans les préférences « Project Settings».

Visualisation des médias dans la Page Media.

Cliquez sur la roue dentée en bas à gauche de la fenêtre pour ouvrir la fenêtre Project 
Settings. Dans Conform Options > Calculate timecode at > choisir 29,97 ou une autre 
fréquence d’image suivant vos rushes.
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5.2 Importer les médias :

Pour pouvoir travailler, il nous faudra importer les clips du disque dur dans le dossier 
«Media Pool» du logiciel. Pour cela, nous disposons de trois solutions :

• Double clic sur les médias pour les importer.
• Glissez/déposez les clips vers l’onglet Média Pool en bas à gauche.
• Clic droit sur le clip puis choisir > Add to media Pool.

Par défaut, tous les médias importés dans un projet iront dans un dossier «Master» du 
Media Pool. Pour vous organisez, vous pouvez créer des dossiers que vous renommerez 
et dans lequel vous y placerez des clips manuellement....

Une fois les médias dans le Media Pool, vous pourrez les manager avec des 
métadonnées que vous pourrez modifier dans la fenêtre Metadatas du logiciel :

Gestion des métadonnées dans l’Onglet Medatadas.
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Puis en appuyant sur + de l’onglet Media Tool vous pourrez rajouter des dossiers pour y 
ranger vos clips (meilleur organisation des médias).
Vous pouvez renommer ces dossiers pour une meilleur organisation.
Sélectionnez vos clips avec Shift ou Cmd, puis glissez les dans le nouveau dossier créé 
précédemment.

Vous pouvez grossir la visualisation des vignettes avec le curseur en bas à droite du 
Media Pool :

En supprimant un bin du Media Tool, vous supprimerez le dossier et son contenu du 
Media Pool mais pas des disques durs.

Pour supprimer des clips, sélectionnez les, puis Delete du clavier. Un message d’alerte 
vous signifiera que vous supprimé un clip :

Lorsqu’un dossier est choisi, lorsque vous importez des médias ceux-ci seront directement 
glissés dans ce dossier.
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5.3 Les médias Offline (vérification) :

On peut amener dans ce dossier des clips, mais aussi des masques et des film en 
quicktime que l’on appelle des fichiers offline.

Un fichier Offline est un fichier de basse qualité. Celui-ci, vous permettra de vérifier si les 
médias importés et leur ordre est conforme avec le montage initial. 

5.3.1 Exporter un film de FCPX dans une qualité H264 :

Choisissez Partager 

Donnez lui un nom et validez les réglages de votre export :

Dans DaVinci, importez le en sélectionnant Ctrl+clic sur le rush et «Add as Offline Clip».
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Ce clip Offline ne sera pas visible dans la timeline Confom du logiciel, il nous servira 
seulement  de repère pour vérifier un import XML, EDL ou AAF que l’on verra lors de 
l’étude de la Page Conform. Voir dossier vérification.

La page Conform, le fichier Offline n’est pas introduit dans la Timeline.

5.4 Organiser son travail : 

Pour organiser facilement nos médias, on va rajouter un drapeau au clip qui nous servira 
de contrôle. Dans l’onglet Métadata, choisir dans le menu déroulant «Shot & Scene» et 
cliquez sur le drapeau rouge.

Ce drapeau nous permettra lors d’une recherche sur la timeline d’isoler tous les plans qui 
possèdent un drapeau ou un repère que l’on verra plus tard.

On peut organiser la visualisation des fenêtres en mode vignette, texte et faire une 
recherche des clips dans la barre des outils de la Library ou du Media Pool
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Pour changer de mode, choisissez le mode de visualisation dans la barre d’outils :

Remarquez la différence entre les clips classiques directement accessibles dans la 
timeline pour l’étalonnage et un clip Offline :

Remarque :

Lorsque vous rajoutez une fichier ou changez l’organisation d’un disque dur, il vous faudra 
faire un «Refresh». Cette manipulation re-scannera les disques pour qu’il prenne en 
compte les changements d’organisation.

Ci-dessous, on a créé un nouveau dossier pour deux fichiers Proress 444 qui 
correspondent à des fichiers vidéos avec une couche alpha pour pouvoir superposer des 
titres sur une vidéo.
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Pour comprendre les fichiers avec alpha  : voir la leçon sur le site. Link sur Video Effects 
Prod.

Une fois vos médias dans le Media Pool vous pouvez passer à l’étape suivante, mais 
avant on va sauvegarder notre travail.

5.6 Sauvegarder son travail :

Pour travailler dans de bonne condition, il est important de sauvegarder son travail. 
Ceci pour plusieurs raisons : 

• Retrouver son travail lorsque l’on ré-ouvre le logiciel.
• Ne pas perdre tout ce que l’on a fait en cas de plantage du système.

On va dans File > Save Project ou Cmd+S :

Une fois son projet sauvegardé et seulement dans ce cas, on peut mettre ON la procédure 
de sauvegarde automatique. Celle-ci se trouve dans les paramètres du Project (Roue 
dentée en bas à gauche) :

Auto Save > Automatically save project > ON

Apply pour valider notre choix.

Une fois tous nos médias choisis en mode manuel, on peut cliquer sur la page Conform 
pour organiser notre travail.
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Si on importez directement un fichier XML, EDL ou AAF, vous vous rendrez directement 
sur cette page.

6. La page Conform :

Cette nouvelle page vous permettra d’affiner votre montage. Si vous travailler avec des 
médias sans montage vous pourrez choisir l’ordre des sources dans la timeline, de 
visualiser les effets, placer de nouveaux calques comme des titres ou autres etc...

Importez des rushes dans la Page Media comme vu précédemment, puis cliquez sur la 
Page Conform dans la barre de gestion des pages en bas de le fenêtre de travail.

Vous pouvez organisez vos fenêtres en jouant sur les bordure de chaque fenêtre. En bas 
de la timeline à droite vous avez une flèche pour agrandir la timeline :

En cliquant sur cette flèche, vous agrandirez la timeline en réduisant les autres fenêtres 
vers le haut :
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Agrandissement de la timeline dans la Page Conform.

Nous allons découvrir les différentes fenêtres composants cette page :

6.1 La Master Timeline :

Dans cette page, DaVinci va créer automatiquement une Master Timeline. Celle-ci 
comprendra l’ensemble des fichiers incorporés dans la page Media Pool.
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un timecode de début, le nombre d’image de votre séquence, sa durée en temps, la 
fréquence du projet et vous signifie si un clip est un fichier Offline etc....

Vous pouvez réorganiser les fenêtres en jouant sur les traits verticaux ou horizontaux de 
la fenêtre globale du logiciel :

Remarque :

En quittant le logiciel, vous retrouverez cette nouvelle organisation dans l’état où vous 
l’avez quittée.

Dans cette Master Timeline, vous retrouverez tous les clips et les annotations rajoutés 
auparavant comme les drapeaux. Ceux-ci peuvent vous permettre de marquer les clips 
pour des travaux spéciaux à faire.

Master Timeline avec des drapeaux Rouge, Jaune et Vert.

On peut organiser les différentes colonnes de l’onglet Media Pool en les glissant à 
l’emplacement choisi.

Ci-dessous, on a ramener la colonne flag pour organiser les médias suivant la couleur 
des drapeaux :
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A l’intérieure de la timeline, pour se déplacer entre les plans, on peut utiliser les flèches 
haut et bas du clavier.

Aucunes modifications ne peut être effectuées sur la Master Timeline. C’est à dire qu’elle 
respecte scrupuleusement l’ordre de l’importation des rushes dans la Page Media.
Pour pouvoir rajouter des clips, des masques ou bien changer la longueur des clips, il 
nous faudra obligatoirement créer une nouvelle timeline.

Le logiciel peut gérer plusieurs timelines. Le choix s’effectue dans la page Color au 
dessus du Viewer. Vous avez le nom de la timeline et un menu déroulant pour 
sélectionner celle sur laquelle vous souhaitez travailler.

11.3 Les Memory :

Lorsqu’un étalonnage est souvent rappelé, il est nécessaire de le stocker dans les 
mémoires que l’on appelle «Memory». 

Pour sauvegarder un réglage ou le rappeler :
Dans le menu Color > Memory > Load ou Save Memory de 1 à 8.

On aura accès à des raccourcis pour rappeler les mémoires stockées dans la Gallery :

• Save Memory Alt de 1 à 9
• Load Memory Cmd de 1 à 9
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N’oubliez pas de regarder toujours avec un clic droit sur les images ce que l’on peut avoir 
comme options :

• Switch Wipe Mode : dans le Viewer permet de rentrer dans le mode wipe de 
comparaison entre deux images. C’est la même fonction que pour les Stills.

• Play Memory : on rentre aussi dans le mode wipe.
• Add Correction : affecte la mémoire d’étalonnage au plan du Viewer.
• Append Node Graph : affiche l’onglet Nodes de la mémoire.
• Display Node Graph : masque l’affichage précédent.
• Clear : supprime la mémoire de l’onglet Gallery.
• Properties : affiche les propriétés de la mémoire.
• Export : nous permet d’exporter le powerGrade pour le sauvegarder dans un 

autre endroit ou l’importer sur une autre station.
• Export With Display LUT : permet d’exporter le PowerGrade pour en faire un 

qui permet de gérer l’affichage du Viewer.

Utilisation de la Memory avec le mode Wipe pour comparer deux images dans le Viewer.

12. L’onglet Nodes :

© Frédéric Robin février 2013 ! 32



Cet onglet gère les Nodes (noeud en français). Ces noeuds nous permettent de poser 
différentes corrections sur une image. On pourra masquer ou non l’effet pour voir ce 
qui se passe sur l’image.

Onglet Nodes avec trois Nodes en série.

Dans l’onglet Nodes ci-dessus nous avons trois nodes en série.

Il existe plusieurs types de nodes qui sont :

Serial Node : node série qui se place dans la continuité de la chaine.
Serial Node Before : place un node série avant le node que l’on a sélectionné.
Parallel Node : qui est un node parallèle qui permet de traiter plusieurs niveaux de 
correction en même temps.
Layer Node : noeud de key pour mélanger les entrées et obtenir des effets différents de 
correction couleur.
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Utilisation d’un Parallel Node pour voir le mélange des couleurs sur trois nodes.

23. Exemple de travail avec les rushes de Blackmagic : 

Pour commencer nous allons travailler avec les sources que nous fourni Blackmagic à 
cette adresse :
http://www.blackmagicdesign.com/support/detail?sid=3948&pid=11735&leg=false&os=mac

Installer les médias sur un disque rapide pour profiter du logiciel.

• Ouvrez le logiciel.
• Créer un nouveau utilisateur.

Une fois votre compte créé, double cliquez sur le projet par défaut :
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Vous premier projet ouvert, vous atteindrez la page des médias, qui est la première des 
cinq pages du logiciel pour organiser votre projet.

Chaque page peut être ouverte en cliquant sur le dock de sélection du logiciel (en bas) :

Ces pages sont arrangées dans l’ordre de travail, la page Média est celle qui gère les 
médias avec leur emplacement. 

Dans la Librairie allez chercher vos médias du tutoriel sur le disque dur où vous les 
avait placé.

Dans notre cas nous avons placé les médias sur le bureau de notre Mac... donc on se 
rend dans le Desktop de la racine de l’utilisateur de l'ordinateur. Dans le dossier tutoriel 
vous aurez 5 clips pour les exercices qui vont suivre.

Pour démarrer ,on va ouvrir un projet DaVinci Resolve. Cliquez sur la page Conform du 
dock de sélection des pages.

Cette page contient la liste des timelines du logiciel et celle du monteur. Vous pourrez y 
importer les projets de vos logiciels de montage grâce aux XMLs et préparer votre travail 
en réorganisant vos plans.
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Choisissez File > Import AAF/EDL/XML et dans le menu choisissez le fichier XML «Cafe 
tutorial» situé dans le dossier «Tutorial media» que vous avez sur le bureau ou ailleurs 
lorsque vous avez copié les médias fourni par Blackmagic.

La boite de dialogue de chargement de XML apparait :
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Tous les réglages par défauts sont corrects, vérifiez bien que «Automatically import 
source clips into Media Pool» est bien cochée. cette option confirme que vous importez 
les médias dans le dossier média tool du logiciel. Une opération primordiale pour 
démarrer votre travail sous DaVinci Resolve.
Une nouvelle boite de dialogue vous permettra de spécifier le chemin d’accès des 
médias sur vos disques.
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Une fois le chemin validé, le Media Pool organisera votre timeline avec les contenus du 
projet. Les médias seront rangés dans l’ordre de votre logiciel de montage comme ci-
dessous :

Nous allons faire une sauvegarde de notre projet en cours; Appuyez sur les touches Cmd
+S et donnez lui un nom et cliquez sur Create :

23.1 Naviguez dans le projet et utiliser les outils «Scopes» :

Maintenant que votre projet est ouvert, nous allons nous rendre dans la page Color du 
logiciel pour commencer l’étalonnage de nos rushes ou montage.

C’est la page principale pour les corrections couleur du logiciel :
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A gauche en haut vous avez le visualiseur des médias qui vous montre l’image sous le 
curseur de la timeline qui se trouve au milieu. Appuyez sur play pour lire la séquence ou la 
barre espace.

Si votre ordinateur est assez puissant vous pourrez lire en temps réel vos médias. Sinon 
essayez de passer en mode Offline pour réduire le poids des fichiers en utilisant le 
raccourci Alt+P.

Pour passer à un autre clip directement, il vous suffit de cliquer sur les vignettes de la 
timeline ou les flèches haut / bas.

Sur la timeline, les clips sont représentés par des lignes grises et oranges quand elles 
sont en lecture ou sélectionnés pour travailler :
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Vous savez maintenant naviguez dans la timeline à travers les clips, pour passer à l’étape 
suivante : la correction couleur. Pour bien travailler et voir le signal, il vous faudra ouvrir 
les outils de scopes pour vérifier et ajuster le signal.

Choisissez votre clip, puis dans le visualiseur faite un Ctrl+clic et «Show Scopes».

Une fenêtre s’ouvre avec les 4 fenêtres de visualisation du signal :

• Le Waveform
• La parade RVB
• Le Vecteurscope
• L’histogramme

Si vous ne possédez pas les connaissances sur comment lire c’est signaux reportez vous 
à la leçon sur le site : «FCPX : lire les outils d’étalonnage».
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Vous pourrez déplacer la fenêtre où bon vous semble dans votre écran et si vous 
disposez d’un deuxième moniteur pas de soucis utilisez le....

23.2 Faire une correction de couleur primaire :

Cliquez sur le bouton de «roues de palette couleur» 

Cette action affichera l’interface des roues de couleur montrant les contrôle de Lift, 
Gamma et Gain du signal pour ajuster la balance des blancs et le contraste de l’image.
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Trois roues de couleur pour la balance des blancs, vous pourrez y ajuster la couleur des 
noirs, les lumières moyennes et les hautes lumières indépendamment les unes des 
autres.

En dessous se trouve 3 roues Master pour ajuster le point blanc, les gammas et le 
point noir.

Choisissez le premier clip de la moto dans la timeline donc soit en plaçant le curseur sur le 
clip dans la timeline, soit en déplaçant votre curseur sur le clip.

 

On peut voir que l’image est assez sombre via l’histogramme et la parade RVB... donc 
on va jouer sur le gamma de l’image en déplaçant la roue Master du gamma vers la 
droite.
On regardera en même temps les scopes bouger et l’image s’éclaircir :
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L’idéal est de placer les couleurs de l’histogramme vers le centre de l’image pour 
essayer qu’au final des réglages, le signal occupe tout le spectre.

L’image est plus lumineuse mais les noirs sont complètement décollés. Du fait du 
changement de colorimétrie par rapport à l’original ,vous devriez apercevoir une ligne 
colorée en dessous de la vignette du clip dans la timeline. Cette ligne signifie que vous 
avez modifié la colorimétrie de l’image. On dit qu’un Grade a été appliqué.

Pour modifier les noirs, déplacer la roue du Lift Master vers la gauche jusqu’à atteindre le 
niveau 0 du Waveform.

Remarque :
Pour votre information : le Waveform vous informe sur le signal vidéo. Le principe est 
simple vous devrez ne pas dépasser les 100 mVolts et le 0 mVolt du signal. Ce sont 
les normes pour une diffusion télévisuelle. Hors sur DaVinci on a une visualisation avec 
des mesures en 1023 et 0 ce qui correspond à un signal 10 bits.
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En déplaçant les noirs vers le O Volt, on augmente la distance entre les blancs et les noirs 
de l’image donc on augmente le contraste de l’image.

Pour mieux voir les différentes vues des scopes,vous pouvez en sélectionner un ou plus 
et travailler sur la luminance de visualisation de la fenêtre. 

Près de la fenêtre de la Parade RVB vous avez un menu déroulant avec 1UP, 2UP ou 
4UP. Choisissez 1UP.

Puis dans le Pop menu choisissez la fenêtre que vous souhaitez visualiser. Dans Switch 
View > Switch to parade ou une autre à vous de voir.

Maintenant vous avez une seule visualisation de la fenêtre parade :

© Frédéric Robin février 2013 ! 44



Cette vue vous permettra de mieux appréhender les niveaux de couleur Rouge, Verte et 
bleu de votre image. Ici nous avons une égalité entre les différentes composantes de 
l’image ce qui est bon signe pour un bon réglage.

Si l’image de la Parade RVB vous semble trop forte ou trop faible vous pouvez contrôler 
sa luminosité dans le menu déroulant avec Brightness ou Reference Level.

24. Travaillez avec Final Cut Pro X :

Une fois le montage fini dans un logiciel de montage, enregistrez un fichier Quicktime 
basse définition pour pouvoir comparez avec le fichier XML dans DaVinci.

Ouvrez le logiciel DaVinci Resolve 9 Lite.

24.1 Préparer votre projet dans le Resolve :

Vérifiez vos «Settings Projet» et les disques connectés à votre logiciel. 

Lorsque le logiciel s’ouvre, on vérifie le format de nos images pour faire correspondre 
notre projet avec celui de DaVinci.
Notre montage source se trouve sur un disque externe que l’on a connecté au Resolve. 
Ouvrez les Préférences et vérifiez l’onglet «Media Storage» pour la suite du travail et 
notamment le stockage des rendus, l’exportation etc...
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Sauvegardez la configuration avec SAVE.

Choisissez un média et regardez ces spécifications de format dans le panneau Metadata :

Notre fichier source nous indique :

• Son dossier d’origine
• Sa durée : 3’53’’06
• Sa résolution : 1920x1080 (taille maximum de la version Lite)
• Sa fréquence : 25 im/sec
• Le codec : Apple Proress 422 HQ.

On va de suite vérifier les settings du projet car on ne pourra pas le changer par la 
suite de notre travail.
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31. Conclusion :

DaVinci est un logiciel qui possède de nombreuses possibilités de trucage colorimétrique, 
nous n’avons pas abordé toutes les possibilités du programme. Notamment les notions de 
LUT, du traitement des formats RAW, des keyframing puissants, des notions de montage, 
de la gestion des métadonnées etc.... seront développés dans un autre PDF qui viendra 
dans l’année dans une deuxième version «Technique avancé». 

Vos questions dans le forum du site de Video Effects Prod : lien de la page.

Si vous rencontrez des erreurs dans le PDF, je serais ravi de les rectifier et de vous faire 
parvenir une nouvelle version avec les modifications.

N’hésitez pas à me contacter sur le mail motionapple@gmail.com seulement dans le cas 
de mauvaise rédaction ou de correction, pour tout autre question sur le fonctionnement du 
logiciel, rendez vous sur le forum.

A bientôt sur le site....

Frédéric Robin
Video Effects Prod
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